1-21-2019

Survey of Computer-Aided Engineering Software for Mechanical Design

Sylvia Tan  
*Washington University in St. Louis*

Mark Jakiela  
*Washington University in St. Louis*

Follow this and additional works at: https://openscholarship.wustl.edu/mems500

Recommended Citation
https://openscholarship.wustl.edu/mems500/85

This Final Report is brought to you for free and open access by the Mechanical Engineering & Materials Science at Washington University Open Scholarship. It has been accepted for inclusion in Mechanical Engineering and Materials Science Independent Study by an authorized administrator of Washington University Open Scholarship. For more information, please contact digital@wumail.wustl.edu.
Survey of Computer-Aided Engineering Software for Mechanical Design

Sylvia Tan
Advisor: Dr. Mark Jakiela

Department of Mechanical Engineering & Material Science
Washington University in St. Louis

December 2018
Table of Contents

1 Introduction ........................................................................................................................................... 2
  1.1 Uses in Industry ............................................................................................................................. 2
  1.2 Uses in Academia .......................................................................................................................... 2
2 Types of CAD ....................................................................................................................................... 3
  2.1 AutoCAD – 2D............................................................................................................................... 4
  2.2 SolidWorks – 3D........................................................................................................................... 4
3 Types of FEA software ...................................................................................................................... 4
  3.1 HyperWorks .................................................................................................................................. 5
  3.2 COMSOL ....................................................................................................................................... 5
4 Review of current CAD and FEA classes at WUSTL ........................................................................... 5
  4.1 MEMS 103 Computer Aided Design – AutoCAD ................................................................. 6
  4.2 MEMS 202 Computer-Aided Design ....................................................................................... 6
  4.3 MEMS 5104 CAE-Driven Mechanical Design ......................................................................... 6
  4.4 MEMS 3110, MEMS 411, MEMS 424 ....................................................................................... 7
    4.4.1 MEMS 3110 Machine Elements .............................................................................................. 7
    4.4.2 MEMS 411 Mechanical Engineering Design Project ............................................................ 7
    4.4.3 MEMS 424 Introduction to Finite Element Methods in Structural Analysis .................... 7
  4.5 Problems ......................................................................................................................................... 7
5 Proposed Solution ............................................................................................................................... 8
  5.1 Solid Modelling ............................................................................................................................ 8
  5.2 Motion Analysis ............................................................................................................................... 8
  5.3 Static Analysis ................................................................................................................................. 9
  5.4 Fluid Flow Analysis ........................................................................................................................ 9
  5.5 Topology Optimization .................................................................................................................. 10
  5.6 Manufacturing Processes .............................................................................................................. 10
    5.6.1 Forming .................................................................................................................................... 10
    5.6.2 Casting .................................................................................................................................... 11
6 Conclusion ........................................................................................................................................... 11
7 References .......................................................................................................................................... 13

Appendix A – Solid Modeling in Inspire .............................................................................................. 14
Appendix B – Motion Analysis in SolidWorks ..................................................................................... 21
Appendix C – Static Analysis in SolidWorks ......................................................................................... 23
Appendix D – Fluid Analysis in SolidWorks ......................................................................................... 29
Appendix E – Fluid Analysis in COMSOL ............................................................................................ 33
Appendix F – Optimization in SolidWorks ............................................................................................ 39
Appendix G – Optimization in Inspire .................................................................................................. 42
Appendix H – Click2Form ..................................................................................................................... 45
Appendix I – Click2Cast ......................................................................................................................... 50
1 Introduction

Computer-Aided Design (CAD) is the use of “computer software to facilitate the generation, modification, and optimization of a part or a compilation of parts” [1]. With it, parts with a higher precision are achievable within a shorter time, and multiple design iterations can be easily completed. As such, it is widely used in all industries and academia as it streamlines the product development and reduces cost significantly. An extension of CAD programs are Finite Element Analysis (FEA) or Computer-Aided Engineering (CAE) software that focus on the analysis and optimization of parts and models. They are used to solve complex mathematical models that simulate real-world working environments that are otherwise time and labor intensive to solve manually.

1.1 Uses in Industry

In industry, where efficiency and productivity are essential to any business, the use of CAD has become ubiquitous. CAD tools are used to streamline the product development by (1) allowing for faster design execution, (2) more precision and control, and (3) ease of communication.

For example, in the aerospace industry, Boeing first used CATIA in 1988 to develop the 777 aircraft [2]. It was the first jetliner that was entirely digitally designed, and it could be “preassembled” in the software. This reduced cost significantly as full-scale mock-ups were not needed. Currently, it is still using CATIA to design all its commercial airplanes in Seattle, and in the defense section in St. Louis, Unigraphics is being used [3].

Outside of the aerospace industry, many other programs are used extensively in manufacturing, automotive, electronics, construction and medical industries. Additionally, the entertainment industry uses CAD to create animations.

1.2 Uses in Academia

In academia, although full-scale productions are not being performed, CAD is still an essential tool that is used to design components for research projects, and FEA is extensively used to understand how new innovations will perform under different conditions that have never been tested before.

At Washington University in St. Louis’s Mechanical Engineering department, although the research is not focused on design, programs such as SolidWorks, AutoCAD, ANSYS and COMOSL are being used to aid in the research effort.

Therefore, learning how to use CAD and FEA software is essential for mechanical engineering students as it is a skill they need in order to succeed in either industry or academia. However, with the multitude of CAD and FEA programs available and being used, learning how to use all the programs is not realistic. Therefore, it is up to the school’s discretion as to what they choose to teach the students.

Here at Washington University in St. Louis, although SolidWorks is being taught to all undergraduate students, it is only an introductory class that provides a simple overview of the program. Additionally, graduate students are not required to take any CAD class despite some students choosing to graduate with a specialization in Mechanical Design. Therefore, this project aims to create graduate class course materials that introduce the students to a wider range of CAD and FEA programs. A survey of the programs
was also completed to help determine which programs are the most beneficial for the students to understand.

2 Types of CAD

CAD software can be broken down into 2 main types: (i) 2-Dimensional CAD, and (ii) 3-Dimensional CAD, where they each have many products available on the market at varying costs and abilities.

2D CAD software, as the name suggest allows for the creation of flat drawings that only consist of two dimensions. As such, they are most often used to create technical drawings, building inspections plans, and landscape layout [4]. Although 2D drawings can be made manually, the software allows for greater precision and is more time efficient.

3D CAD modelling software can be further broken down into three types: (i) wire-frame models, (ii) surface models, and (iii) solid models [5].

Wire-frame models are the most abstract form of modelling as it contains only points and lines that define the edges of an object. Although they do not provide a high density of information, they are simple to calculate and render, and thus are used in initial design phases where changes are happening at a quicker rate.

In contrast, surface models provide a depiction of the external surface of a part as well. However, similar to wire-frame models, they only contain a portion of the information, since there is no representation of internal volume, they allow for easy free-form shape manipulation. As such, the entertainment industry is a large user of this form of modelling as they are concerned with the aesthetics of their animations, rather than the functionality of them.

Lastly, solid modelling consists of every aspect of the 3D object. It allows for separate objects to interact with each other allowing them to intersect, join, and subtract from one another. “Watertight” features are created, and they are parametric where dimensions and relations are provided that allow for exact modifications to be made to the object. Moreover, the dimensions and relations aids the manufacturing process as the object’s features are clearly defined. Therefore, industries such as automotive and aerospace use solid modelling techniques since there is more control over how the parts are modeled that allows for ease in manufacturing.

In all, each form of modelling technique has its advantages and disadvantages that need to be considered when choosing a software to use. However, it should be noted that 3D CAD modelling software is often able to perform the abilities of a 2D modelling software, and similarly, a solid modelling software would be able to create a surface or wire-frame model. Therefore, a strong 3D CAD modelling software is often chosen.

According to CNC Cookbook’s 2016 and 2017 survey of the CAD market share, SolidWorks, a 3D solid modeling program, was the top company in both the 2D and 3D market with a 19.6 % and 20.8 % market share in 2016 and 2017 respectively (fig. 1) [6,7]. Additionally, among the top 10 market share holders of CAD programs, six are 3D programs (SolidWorks, Fusion 160, Autodesk Inventor, Rhino3D, SketchUp, and Alibra), two are 2D CAD programs (AutoCAD and Draftsight), and two are specifically for CNC machining.
(BobCad and Vectric). It should be noted that the two 2D CAD programs are developed by the 2 largest 3D CAD companies (AutoCAD is part of AutoDesk that includes Inventor and Fusion 360, and Draftsight is part of Dassault Systems that includes SolidWorks).

![CAD Market Share of Top 10 Players](image)

*Figure 1. Market Share of Top 10 CAD software in 2016 and 2017*

2.1 **AutoCAD – 2D**
AutoCAD is a program developed by Autodesk that allows for the creation of 2D and 3D drawings. As seen in Figure 1, AutoCAD is the largest market share holder among 2D CAD software with a market share of 8.3% and 8.4% in 2016 and 2017 respectively. This can be attributed to the fact that unlike many other modeling software, AutoCAD, and other AutoDesk software, is compatible on both Windows and Mac.

2.2 **SolidWorks – 3D**
In contrast, SolidWorks is a 3D solid modelling software that utilizes a parametric feature-based method. It also includes analysis capabilities that are not possible with a 2D modeler. As such, it is extensively used in industry and has become one of the most common programs taught in schools (WUSTL included).

3 **Types of FEA software**
Although most CAD programs also include the ability to analyze parts, their capabilities are limited and thus, FEA programs are used instead. These programs use the finite element method to solve complex numerical models that are generally a solution to a boundary value problem for partial differential equations.

The types of analyses that FEA software is able to solve includes, but are not limited to, stress, fluid flow, heat transfer, and electromagnetics analysis.
3.1 HyperWorks

HyperWorks is a suite of CAE software programs where each program is designed to perform a specific analysis. As such, it is a comprehensive analysis tool that is widely used in the automotive industry. Additionally, it is a part of Altair Engineering, which also houses SolidThinking (including Inspire and Evolve) that has a simpler user-interface compared to HyperWorks.

3.2 COMSOL

COMSOL is a Multiphysics modeling software that consist of application areas such as Electrical, Mechanical, Fluid, Chemical, Multipurpose, and Interfacing [8]. The various modules can be combined together and all the analysis perform within the same workflow. Due to is general purpose, COMSOL is widely used in scientific research as well.

4 Review of current CAD and FEA classes at WUSTL

Currently within WUSTL’s Mechanical Engineering department, there are 3 classes across the undergraduate and graduate levels that have an emphasis on learning a new CAD/ FEA software: (i) MEMS 103 Computer Aided Design – AutoCAD, (ii) MEMS 202 Computer-Aided Design, and (iii) MEMS 5104 CAE-Driven Mechanical Design. Outside of these classes, there are additional classes that use other forms of CAD or FEA software as part of the class, but the understanding of how to use the software is not the priority of the class.

Among the three classes that do prioritize a CAD or FEA program, only MEMS 202 is a required undergraduate class, while MEMS 103 and MEMS 5104 are an elective undergraduate and graduate class respectively.

Table 1 shows the breakdown of the number of students who took the three previously mentioned classes over the course of 3 academic years. As seen, the number of students enrolled in the required undergraduate MEMS 202 class is significantly larger than that in the elective MEMS 103 class, where the MEMS 202 class is an average 175% larger than the MEMS 103 class.

Table 1. Breakdown of the number of students enrolled in MEMS 103, MEM 202, and MEM 5104 for each semester over the past 3 years

<table>
<thead>
<tr>
<th></th>
<th>FL 16’</th>
<th>SP 17’</th>
<th>YR 16-17</th>
<th>FL 17’</th>
<th>SP 18’</th>
<th>YR 17-18</th>
<th>FL 18’</th>
<th>SP 19’</th>
<th>YR 18-19</th>
</tr>
</thead>
<tbody>
<tr>
<td>MEMS 103</td>
<td>10</td>
<td>-*</td>
<td>10</td>
<td>10</td>
<td>-*</td>
<td>10</td>
<td>7</td>
<td>-*</td>
<td>7</td>
</tr>
<tr>
<td>MEMS 202</td>
<td>88</td>
<td>39</td>
<td>127</td>
<td>88</td>
<td>54</td>
<td>142</td>
<td>106</td>
<td>27***</td>
<td>133</td>
</tr>
<tr>
<td>MEMS 5104</td>
<td>-**</td>
<td>-***</td>
<td>-**</td>
<td>34</td>
<td>-*</td>
<td>34</td>
<td>31</td>
<td>-*</td>
<td>31</td>
</tr>
</tbody>
</table>

*class not offered in this term
** class has not been made yet
*** students registered for the class as of 12/8/2018

In all, despite the high frequency with which AutoCAD is used in industry, undergraduate students do not know of this and thus, the number of students enrolled in MEMS 103 is small.
4.1 MEMS 103 Computer Aided Design – AutoCAD

According to the course listing, MEMS 103 is an introduction to AutoCAD, title blocks, drawing setup, absolute and relative coordinates, drawing entities, layouts, drafting geometry, dimensioning, plotting drawings to scale, sectional and other special views, isometric pictorial views". [9]

The class is taught using Shih’s “AutoCAD 2018 Tutorial First Level 2D Fundamentals” [9] and the students spend each class going through tutorials in the textbook. The class is worth 3 credits and despite the usefulness of the class, it is only offered once a year in the fall due to the small enrollment as it is not required for mechanical engineers.

4.2 MEMS 202 Computer-Aided Design

In comparison, MEMS 202 is a required class for all mechanical engineers. It is suggested that every mechanical engineering student take the class in their first year, and all transfer and dual-degree students have to take the class if they are unable to transfer the appropriate credits from their previous institution.

According to the course listing, MEMS 202 is an introduction to computer aided engineering design in the context of mechanical and structural engineering. Students learn the fundamentals of spatial reasoning and graphical representation. Freehand sketching skills, including pictorial and orthographic views, are applied to the design process. Computer modeling techniques provide accuracy, analysis, and visualization tools necessary for the design of structures, devices and machines. Topics include: detailing design for production, fasteners, dimensioning, tolerancing, creation of part and assembly drawings, computer aided design, analysis and optimization of parts and assemblies; solid modeling of complex surfaces, assembly modeling, assembly constraints, and interference checking. [10]

The class uses both Shih’s “Parametric Modeling with SolidWorks 2017“ for learning SolidWorks, and Craig’s “Engineering Graphics - Technical Sketching (Series 5)” for learning how to hand sketch [10]. Since the fall 2017 semester, the students are also given the option at the end of the semester to take the Certified SOLIDWORKS Associate (CSWA) test and approximately 89 [11] students have taken it (*39 are signed up for fall 2018 as of 12/8/2018).

4.3 MEMS 5104 CAE-Driven Mechanical Design

At the graduate level, there is only one class currently available that focuses on learning the use of a CAD/CAE program. MEMS 5104 was recently introduced in the fall of 2017 and according to the course listing, it is an introduction to the use of computer-aided engineering (CAE) tools in the mechanical design process. Topics include: integrating engineering analysis throughout the process; multi-disciplinary optimization; and computer-aided design directed toward new manufacturing processes. Students will
work with commercial and research software systems to complete several projects. Students should have experience and familiarity with a CAD tool, optimization and the finite element method. [12]

For graduate students, it listed only under the Dynamics/Mechanical Design specialization [13] and unlike the undergraduate class, it introduces the students to a wider range of programs that include SolidThinking Inspire, SolidThinking Click2Cast, SolidThinking Click2Form, HyperWorks, SolidThinking Evolve. It should also be noted that there are no pre-requisites for the class.

4.4  MEMS 3110, MEMS 411, MEMS 424

Aside from the above mentioned 3 classes, there are two additional undergraduate classes (MEMS 3110 and MEMS 411) that integrate CAD into the class, and one graduate class (MEMS 424) that teaches the theory behind how FEA software functions.

4.4.1  MEMS 3110 Machine Elements

MEMS 3110 is a required class taken by mechanical engineers most commonly in the spring of their junior year. The class is focuses on the “overview of the steps in the engineering design process” and introduces the students to “to several classes of machine elements such as bearings, gears, belts, brakes, and springs” [14]. It is a lecture-based class that includes a weekly lab that teaches the students how to use motion and stress analysis in SolidWorks.

4.4.2  MEMS 411 Mechanical Engineering Design Project

MEMS 411 is the capstone class required for all mechanical engineers where they work in groups to develop a solution to “an open-ended mechanical design problem and finish the semester by presenting a physical prototype and a formal report to an external review board” [15]. To do so, the students are required to use SolidWorks and any other form of CAD or FEA software to design the prototype and perform analysis on it as part of the report. However, as MEMS 3110 is a pre-requisite for the class, the students are assumed to know how to use SolidWorks to perform the necessary task and are not taught how to use the program.

4.4.3  MEMS 424 Introduction to Finite Element Methods in Structural Analysis

Lastly, MEMS 424 is an elective graduate class that introduces the students to the “application of finite element methods to beams, frames, trusses and other structural components” [16]. The class is primarily lectured-based; however, it occasionally includes lab classes where the students learn how to use StressCheck. Overall, the foundation of the class is teaching “the application of matrix methods, energy concepts and structural mechanics to the development of finite element modeling methods” [16].

4.5  Problems

In all, despite the high frequency with which AutoCAD is used in industry, it is not recommended resulting in a low enrollment rate for MEMS 103. Additionally, FEA programs are not being taught to the students at the undergraduate level, and at the graduate level, only MEMS 424 is being taught. For undergraduate students, if they follow the suggested course schedule, they leave WUSTL with only an introductory knowledge of how to use SolidWorks. In addition, graduate students are not required to take MEMS 202
and for those with a specialization in Mechanical Design, they are also not required to take MEMS 5104. Therefore, a graduate mechanical engineering student specializing in Mechanical Design could graduate without having used any CAD/CAE programs.

5 Proposed Solution

To ensure students are given the required knowledge to succeed as mechanical engineers, below are suggested tutorials that expose the students to a wider range of software, including SolidWorks, COMSOL, SolidThinking Inspire, SolidThinking Click2Cast, and SolidThinking Click2Form. They are also exposed to a wider range of topics that include (i) solid modelling, (ii) motion analysis, (iii) static analysis, (iv) fluid analysis, and (v) manufacturing processes.

For each topic, the students go through the exercises in two different programs, giving them the opportunity to directly compare each program to another.

5.1 Solid Modelling

Programs: SolidWorks and SolidThinking Inspire

SolidWorks: A tutorial exists in the software under Getting Started > Introduction to SOLIDWORKS. The students are guided to make a part as seen in figure 2

Inspire: A tutorial the leads the students to create the same part he/she did in SolidWorks is found in Appendix A.

Comparing these software, it should be noted by the students that to create models, one of the biggest differences is that SolidWorks is a parametric modelling software that allows the input of dimensions and relations during modelling. In comparison, Inspire is not primarily a modelling software and thus although some dimensions can be included, it is limited in its capabilities.

5.2 Motion Analysis

Programs: SolidWorks and SolidThinking Inspire

SolidWorks: A tutorial the leads the students to analyze an assembly (fig. 3) in SolidWorks is found in Appendix B.

Inspire: A tutorial is provided in Altair University (https://certification.altairuniversity.com/) where students are able to create an account that includes an exercise (Start Learning > Learn Conceptual Designing and Industrial Design > Learn Conceptual Design with Inspire 2017 > 9. Exercise Motion).
Comparing these programs, unlike modeling, Inspire is a software that was made to ease the process of analyzing objects. As such, obtaining results for different parts within the assembly is simpler in Inspire. However, SolidWorks gives the option of creating an animation which cannot be done in Inspire.

5.3 Static Analysis

**Programs:** SolidWorks and SolidThinking Inspire

**SolidWorks:** A tutorial that leads the students to analyze a bicycle frame (fig. 4) in SolidWorks is found in Appendix C.

**Inspire:** A tutorial is provided in Altair University ([https://certification.altairuniversity.com/](https://certification.altairuniversity.com/)) where students are able to create an account that includes an exercise (Start Learning > Learn Conceptual Designing and Industrial Design > Learn Conceptual Design with Inspire 2017 > 7. Exercise Analysis).

Inspire has a user-friendly interface and multiple different load cases can be analyzed at the same time. In contrast, SolidWorks can only analyze one case each time, and the user has to change the parameters and rerun the analysis for each iteration.

5.4 Fluid Flow Analysis

**Programs:** SolidWorks and COMSOL

**SolidWorks:** A tutorial that leads the students to analyze a pipe (fig 5) is found in Appendix D.

**COMSOL:** A tutorial that leads the students to analyze the same part using COMSOL is found in Appendix E.
When comparing SolidWorks and COMSOL, it should be noted that COMSOL is a program designed for performing analyses. As such, creating a simple model within COMSOL is achievable; however, if more complex shapes are needed, they would need to be modeled elsewhere (e.g. SolidWorks) and imported into COMSOL to be analyzed. Additionally, SolidWorks does have a full-scale fluid flow analysis tool that provides a wider range of options; however, the license that WUSTL has only allows for the use of FloXpress, a simplified version of the full-scale product.

It should also be noted that Inspire was not used as it does not have the option to run a pipe fluid flow analysis.

5.5 Topology Optimization

**Programs:** SolidWorks and SolidThinking Inspire

**SolidWorks:** A tutorial that leads the students to optimize a plate (fig. 6) is found in Appendix F.

**Inspire:** A tutorial the leads the students to optimize the same part is found in Appendix G.

Comparing SolidWorks and Inspire, Inspire has an additional option (PolyNurbs) that allows for the conversion from an optimized part to a clean model that can be used in the manufacturing phase.

It should also be noted that SolidWorks only recently added the topology optimization option in SolidWorks 2018.

5.6 Manufacturing Processes

5.6.1 Forming

**Program:** SolidThinking Click2Form

**Click2Form:** A tutorial that leads the students to perform a forming simulation of a model (fig. 7) is found in Appendix H.
Only Click2Form was used in this section as there are no other software currently available on the computers at WUSTL that can perform the same simulation. Another program that does perform sheet forming simulations is Stampack, where it is used by the automotive (e.g. DENSO), household (e.g. Toshiba) and aerospace (e.g. Mitsubishi) industries as examples [17].

5.6.2 Casting

Program: SolidThinking Click2Cast

Click2Cast: A tutorial that leads the students to perform a casting simulation of a model (fig. 8) is found in Appendix

Only Click2Cast was used in this section as there are no other software currently available on the computers at WUSTL. Another program that perform casting simulations is Flow-3D and it is used by the automotive, aerospace, and energy as examples [18].

6 Conclusion

With CAD and FEA programs being so extensively used in academia and industries, understanding how to use them has become a necessary skill for mechanical engineers to have before entering industry or academia. For 2D modeling programs, AutoCAD is the leading software used. However, for 3D modeling software, the variety of software is more extensive and programs such as SolidWorks, Unigraphics, and Fusion 360 are all equally used. Therefore, learning all the 2D and 3D modeling software is not possible, but having a good understanding of how to use a software can be translated to learning how to use other similar software.
At WUSTL, the undergraduate mechanical engineering students are all taught how to use SolidWorks; however, it is only an introductory class with no future class to expand their knowledge in this should they wish to. At the graduate level, there are no required CAD classes, and for students with a mechanical design specialization, they only have one class, MEMS 5104, that focuses on the use of CAD and FEA programs. Therefore, this independent study produced a roadmap by which a graduate CAE class can follow, using the software currently available on the school’s computer, to give the students a deeper understanding of various programs such that they have the knowledge to then be able to choose the appropriate program to use in their future work.
7 References


Appendix A – Solid Modeling in Inspire

Step 1: Setting Units

1. At the bottom right hand corner of the screen, change the units to MMKS (mm kg N s)

Step 2: Creating the Base Feature

1. Under the Create toolbar in the Geometry ribbon, select Circle by Center and Point
2. Click once in the middle of the plane and a second time to the side, creating the circle
3. Set the dimensions of the circle to 128 mm
4. Right-click twice to exit Sketch mode and enter Push/Pull mode
5. Hold Left-click and drag the face to 7mm
   note: use the center scroll wheel on the mouse to rotate the sketch/model

6. Right-click once when finished to exit Push/Pull mode.

Step 3: Creating the Ring Boss

1. Under the Create toolbar in the Geometry ribbon, select Circle by Center and Point
2. Left click on the top side of the Base
3. Click the Create New Part icon
4. Click once in the middle of the plane and a second time to the side, creating the circle
5. Set the dimensions of the circle to 75 mm
6. **Right-click once** to end the sketch
7. Repeat steps 1-9, setting the dimensions to 65 mm instead
8. Right-click once to enter Push/Pull mode
9. On the bottom left-hand side of the screen, change the view to Iso

10. Select the highlighted surface and extrude it to 12mm

11. Select the inner circle and extrude downwards -12mm
12. Right-click once when finished to exit Push/Pull mode.

Step 4: Creating a Hole

1. Under the Create toolbar in the Geometry ribbon, select Circle by Center and Point
2. Left-click on the top side of the Base
3. Click once in the middle of the plane and a second time to the side, creating the circle
4. Set the dimensions of the circle to 25 mm
5. Right-click once to end the sketch
6. Right-click again to enter Push/Pull mode
7. Select the sketched circle and pull downwards all the way through to create the hole
8. **Right-click once** when finished to exit Push/Pull mode.

**Step 5: Adding Fillets**

1. Under the **Modify** toolbar in the **Geometry** ribbon, select **Fillet Edges**
2. Select the top and side surface
3. **Set the radius to 2mm**
4. **Right-click once** to exit Fillets mode

**Step 6: Creating the Tall Cylinders**

1. Under the **Create** toolbar in the **Geometry** ribbon, select **Line**
2. **Left click on the top side of the Base**
3. **Click the Create New Part icon**
4. **Click in the middle of the part once and directly above it once to create a vertical line**
5. **Right-click once** to end the sketch
6. Under the **Create** toolbar in the **Geometry** ribbon, select **Circle by Center and Point**
7. **Click the top of the line once and create a 27mm circle**
8. **Right-click once** to end the sketch
9. **Repeat steps 1-8 5 more times with each line and circle approximately 60 degree apart from each other**
10. Once completed, right-click once to exit sketch mode and enter Push/Pull mode

11. For each circle, pull it up to **30mm**

12. Once finish, **right-click once** to exit Push/Pull mode.

**Step 7: Creating the Tall Cylinder Holes**

1. Under the **Create** toolbar in the **Geometry** ribbon, select **Circle by Center and Point**
2. Click on one of the top surface of a cylinder
3. Click the **Create New Part** icon
4. Select the center of the circle and create a 15 mm circle
5. Repeat on all 6 cylinders
6. **Right-click once** when finished to enter Push/Pull mode
7. For each circle, **pull downwards** to -30mm
8. Once finished, **right-click once** to exit Push/Pull mode.
9. Under the **Modify** toolbar in the **Geometry** ribbon, select **Boolean**
10. Select **Subtract**
11. For **Targets**, select the **27mm cylinders** and **Ring boss**
12. For **Tools**, select the **15mm cylinders**
13. Ensure **Keep Tools** is **unchecked**
14. Once complete, **right-click once** to exit **Boolean**

---

**Step 8: Adding Fillets to Tall Cylinders**

1. Under the **Modify** toolbar in the **Geometry** ribbon, select **Boolean**
2. Select **Combine**
3. Select the **Tall Cylinders** and **Ring Boss**
4. Once complete, **right-click once** to exit **Boolean**
5. **Right-click once** to exit
6. Under the **Modify** toolbar in the **Geometry** ribbon, select **Fillet Edges**
7. With the radius set to **2mm**, select the corresponding edges as seen below.

8. **Right-click once** when completed.
Appendix B – Motion Analysis in SolidWorks

Step 1: Open the CAD Model

1. Launch **SolidWorks**
2. Click **Open**
3. In the **Open File** window, browse for the **M01_FourBar.SLDASM** and click **Open**

![CAD Model Image]

1. Ensure that the units are set to **MKS**

Step 2: Run a Simple Motion Analysis

1. Click the default **Motion Study 1** Tab at the bottom of the graphic area
2. In the pull down, change **Animation** to **Motion Analysis**

   Note: If Motion Analysis does not appear as an option, ensure that the SOLIDWORKS Motion add-in is activated in the SOLIDWORKS Add-Ins Tab

Step 3: Inspect the Gravity Direction

1. Select the **Gravity** on
2. Select the highlighted edge on the assembly

3. Select **Reverse Direction** if necessary to ensure that the direction is pointing downwards

4. For the **numeric gravity value**, enter **9.81 m/s^2**

5. Click **OK** ✓

6. Click **Play** ▶️ to run the analysis

**Step 4: Add a Motor to Drive the Mechanism**

1. Select the **Motors** ⚙️ on

2. Under Motor Type, select **Rotary Motor**

3. Under Component/Direction, for Motor Location, select the highlighted edge on the **Crank**

4. Click **Reverse Direction** if necessary

5. Under Motion, select **Constant Speed** and set it to **60 RPM**

6. Click **OK** ✓
Appendix C – Static Analysis in SolidWorks

**Step 1: Open the CAD Model**

1. Launch **SolidWorks**
2. Click **Open**
3. In the **Open File** window, browse for the **Exercise_4.SLDASM** and click **Open**
4. Ensure that the units are set to **MKS**

**Step 2: Running a Static Analysis**

1. Under the **Simulation** Tab, Select **New Study**
2. Under **Type**, Select **Static**
3. Click **OK**

**Assigning Material**

1. Right click **Parts** and click on **Apply Material to All**
2. Expand **Aluminium Alloys** and select **7050-T6 (SN)**
3. Click **Apply** and **Close**

**Adding Pin Connectors**

1. Right Click on **Connections** and select **Pin**
2. Under **Type**, ensure **Pin** is select
3. Right Click on **Connections** and select **Pin**
4. For the Cylindrical Faces/Edges, select the highlighted surface on the rocker

5. Select the adjacent highlighted surface of Fork-1 and the adjacent highlighted surface of the rocker

6. Click OK

7. Repeat steps to create a second pin between the rocker and seat tube

Adding Contact Sets

1. In the graphics window, right click on the Rocker and click on the change transparency icon
2. Expand Connections and right click on Component Contacts
3. Select Contact Sets...
4. Under Type, select No Penetration
5. For Faces, Edges, Vertices for Set 1, select the highlighted surface on rocker-1
6. For Faces, Edges, Vertices for Set 2, selected the corresponding face on **Fork-1** in contact with the previously selected face

![Diagram showing contact sets and highlighted faces.](image)

7. Click **OK**

8. Create contact sets for the other contact between **rocker-1** and **Fork-1**, and between the **seat tube** and **rocker-1**

![Diagram showing contact sets for different areas.](image)

*Note: you can use exploded view to select hidden faces*

**Applying Fixtures**

1. Right click on **Fixture** and select **Fixed Geometry...**
2. Selected the cylindrical hole at the bottom of the seat tube.
3. Click **OK**
4. Repeat steps 1-3 but select the surface at the end of the seat tube.
Applying Forces

1. Right click on External Loads and select Force...
2. Select the highlight surface on the Rocker
3. Choose Selected Direction and select the Right Plane from the FeatureManager design tree
4. Under Force, enter 810N for Along Plane Dir 2
5. Check Reverse Direction if necessary

6. Click OK
7. Repeat steps 1 -5 on opposite hole of the rocker
8. Repeat steps 1 and 2
9. Choose Selected Direction and select PLANE1_45deg from the FeatureManager design tree
10. Under Force, enter 2435N for Along Plane Dir 1
11. Check Reverse Direction if necessary

12. Repeat steps 8-11 on the opposite hole on the rocker
13. Right click Force-3 and select Suppress
14. Repeat step 13 for Force-4

**Creating a mesh**
1. Right click on Mesh and select Create Mesh...
2. Change the mesh density such that it is approximately 75% towards Fine
3. Click OK
4. If the mesh fails, increase the mesh density

**Run the Analysis**
1. Click on Run This Study to run the analysis
Step 3: Reviewing the Results
1. Right click on Stress1 (vonMises-) and select Edit Definition...
2. Under Advance Options, check Show plot only on selected entities
3. Click Select Bodies for the plot and select the Rocker
4. Click the Chart Options Tab
5. Check Show Min/Max range on shown parts only
6. Click OK

Step 4: Changing Load Case
1. Right click on Force-3 and click Unsuppress
2. Repeat for Force-4
3. Right click on Force-1 and click Suppress
4. Repeat for Force-2
5. Click on Run This Study to run the analysis
6. Repeat Step 3: Reviewing the Results
Appendix D – Fluid Analysis in SolidWorks

Step 1: Creating the model

1. Launch SolidWorks
2. Create a new Part
3. Ensure the units are set to MKS
4. Create the below sketch on the top plane

5. On the front plane, create two concentric circles at the origin with the dimensions shown below

6. Using the Sweep Boss/Base Feature, select Sketch 2 as the Profile and Sketch 1 as the Path

7. Click OK ✔
Creating End Caps

1. Select the highlighted surface and start a new sketch
2. Click Convert Entities and select the inner circle
3. Click OK ✓
4. Under Features, click Extrude Boss/Boss
5. Under Direction 1,
   a. End Condition: Blind
   b. Depth: 0.01m
   c. Uncheck Merge Results
8. Click Reverse Direction
9. Click OK ✓
10. Repeat steps 6-12 on the other end of the pipe

Changing Appearance of the Pipe

1. Right Click on Part1 in the FeatureManager Design Tree
2. Under Appearance, click Part1
3. Go to the Advanced tab
4. Select the Illumination tab, change the transparent amount to 0.8
5. Click OK

6. Save the model

**Step 2: Running a Flow Analysis**

1. Under Tools > Xpress Products, select **FloXpress**
2. Click **Next**
3. Click **View fluid volume**
4. Click **Next**
5. Select **Water** as the Fluid
6. Click **Next**
7. Select **Volume flow rate**
8. On Boss-Extrude1, right-click and click **Select Others**
9. Select the face of Boss-Extrude1 that faces inwards
10. Set the volume flow rate, $Q$, to $1 \text{ m}^3/\text{s}$
11. Click **Next**
12. Repeat steps 8 and 9 on the other end cap
13. Click **Next**
14. Click **Solve**
Appendix E – Fluid Analysis in COMSOL

Step 1: Creating the model

1. Launch COMSOL Multiphysics 5.3
2. Select Model Wizard
3. Select 3D
5. Click Add
6. Click Study
7. Under the Preset Studies, select Stationary
8. Click Done
9. Under the Geometry Tab, click Work Plane
10. In the setting windows of the work plane, under plane definition, ensure the xy-plane is selected
11. In the Model Builder, right-click Plane Geometry and select Line Segment
12. In the setting window of the Line Segment, for both the Start Point and Endpoint, change Specify to Coordinates
   a. For the Start Point:
      i. xw: 0
      ii. yw: 0
   b. For the Endpoint
      i. xw: 0
      ii. yw: 2
13. Click Build Selected
14. In the Model Builder, right-click on Line Segment 1 (ls1) and click Duplicate
15. Repeat step 13 2 more times such that you have 4 line segments
16. Click on Line Segment 2 (ls2)
17. In the setting window of the Line Segment,
   a. For the Start Point:
      i. xw: 1
      ii. yw: 0
   b. For the Endpoint
      i. xw: 1
ii. \( y_w: 2 \)

18. Click **Build Selected**

19. Repeat for Line Segment 3 and Line Segment 4, increasing \( x_w \) of both the Start Point and Endpoint by 1 each time

20. Under the **Work Plane** Tab, select **Quadratic**

21. In the Graphics window, click once on the **top end of Line Segment 1**

22. Click once **0.5m vertically above** the previous point made

23. Click once **0.5m horizontally to the right** of the previous point made

24. Click once **0.5m horizontally to the right** of the previous point made

25. Finally, click once **0.5 vertically below** the previous point made (i.e. the top of Line Segment 2)

26. **Right-click** once to end the sketch

27. In the setting window, change the type to **Open curve**

28. Click **Build Selected**

29. Repeat steps 19-27 to create 2 more arcs connecting Line Segments 2, 3 and 4 as shown below
30. In the Model Builder, right-click Geometry 1 and select Work Plane
31. In the Settings window of Work Plane 2, under Plane Definition, change the plane to \textit{xz-plane}
32. Under Work Plane 2, right-click on Plane Geometry and select \textbf{Circle}
33. In the Settings window of Circle 1, under Size and Shape, change the \textit{Radius to 0.25}
34. Click on \textbf{Build Selected}

35. In the Model Builder, right-click Geometry 1 and select \textbf{Sweep}
36. For Faces to sweep, select the \textbf{Circle}
37. For Spine Curve, turn on active and select the **line and curve segments**

38. Click on **Build Selected**

**Step 2: Defining Flow Properties and Boundaries**

1. Click on Fluid Properties 1 under Laminar Flow (spf)
2. In the Setting window of Fluid Properties, change the setting to **User defined** for both the **Density** and **Dynamic viscosity**

3. Enter **1000** for Density

4. Enter **8.9e-4** for Dynamics viscosity

5. Under the Physics Tab, click on Boundaries > **Inlet**

6. Select the **highlighted face**

7. Under Boundary Condition, change it to **Laminar inflow**

8. In Laminar inflow, select **Flow rate**

9. Enter **1** for **Flow rate**

10. Enter **0.5** for **Entrance Length**

11. Under the Physics Tab, click on Boundaries > **Outlet**

12. Select the **highlighted face**

13. Leave the **default** settings

---

**Step 3: Meshing and Running the Study**

1. Click on **Mesh 1**

2. In the Setting window of Mesh, change the **Element size** to **Coarser**

3. Click on **Build All**
4. Click on **Study 1** and click on **Compute**

**Step 4: Analyzing the Results**

1. Once completed, in the Model Builder under **Results**, expand **Velocity (spf)**
2. Select Slice and under **Plane Data** in the settings window, Change the **Entry Method** to **Coordinates**
3. Enter `range(0.5,1,2.5)` for X-coordinates
4. Click on **Plot**
5. Right-click on Slice and select **Duplicate**
6. Select Slice 2 and under **Plane Data** in the settings window, change the **Plane** to **xy-planes**
7. Ensure the **Entry Method** is set to **Number of planes**
8. Change **Planes** to 1
9. Under **Inherit Style**, select **Slice**
10. Expand **Title**
11. Change Title types to **None**
12. Click on **Plot**
13. Right-click on **Slice 2** and select **Duplicate**
14. Select Slice 2 and under **Plane Data** in the settings window, change the **Plane** to **zx-planes**
15. Ensure the **Entry Method** is set to **Number of planes**
16. Change **Planes** to 3
17. Click on **Plot**
Appendix F – Optimization in SolidWorks

**Step 1: Creating the CAD model**

1. Launch **SolidWorks**
2. Set the unit to **MKS**
3. Create the sketch shown below on the **front plant**
4. **Extrude** by 0.05m

![Sketch](image_url)

**Step 2: Running a Topology Optimization**

1. Under the Simulation tab, select **New Study**
2. Select **Topology Study** under Design Insight
3. Click **OK**
4. **Right-click** SolidBody 1 and select **Apply/Edit Material**
5. Expand the **Steel** folder and select **AISI 304**
6. Click **Apply** and **Close** after

7. **Right-click** Fixtures and select **Fixed Geometry**...

8. Select the highlighted surface

9. Click **OK**

10. **Right-click** External Loads and select **Force**...

11. Select the inner face of the hole

12. Ensure **Selected direction** is selected

13. Under **Face, Edge, Plane for Direction**, select a vertical edge

14. Enter **100N** for the Force

15. Check Reverse Direction if necessary to have the force point downwards.

16. Click **OK**

17. **Right-click** Goals and Constraints and select **Best Stiffness to Weight ratio (default)**

18. Set Constraint 1 to **50%**

19. Click **OK**

20. Click Run
21. Under Results, right-click Material Mass1 and select Edit Definition...
22. Change the Percentage of original mass to 46% by dragging the slider to the right
23. Click OK

24. Under Results, right-click Material Mass1 and select Export Smoothed Mesh
25. Select New configuration
26. Click OK
Appendix G – Optimization in Inspire

Step 1: Open the CAD model
5. Launch Inspire
6. Set the units to MKS
7. Create the model shown below with the listed dimensions (ensure that each circle is a different part)

Step 2: Defining the Material and Design Space
27. In the Model Browser (F2), select all three parts and right-click to change their material
28. Change the material to Steel (ASIS 304)
29. **Right-click on middle section** and check **Design Space**

---

**Step 4: Adding Loads and Supports**

1. In the **Structure** ribbon, click **Apply Support**
2. Select the **outer face of the thin non-design space**

---

3. **Right-click** when completed
4. In the **Structure** ribbon, click **Apply Load**
5. Select the **inner face of circle**
6. Enter **2500N** as the force
7. Select the appropriate direction such that it is pointed downward as seen below
8. **Right-click** when completed

---

**Step 3: Running an Optimization**

1. In the **Structure** ribbon, click the **Run optimization** button under **Optimize**
2. Change the **Mass targets** to **20%**
3. Click **Run**
4. When completed, click on the **green flag** to view the results
5. Explore the results with the **topology slider**
Appendix H – Click2Form

**Step 1: Preparing the model**

1. Launch **Click2Form**
2. Open **Model_1.x_t**

3. In the Feasibility Tab, click **Extract Face (Midsurface Thin Solid Parts)**
4. Select the surface of the model and click **Midsurface**
5. **Right-click** once when completed
   
   *Note: If the CAD model comes as a thick solid model, a single mid-surface need to be extracted*

6. Click **Fill Hole** under Defeature in the Feasibility tab

7. Click Fill Hole (all holes are automatically filled)

8. Click **Fill Cutout** under Defeature in the Feasibility tab
9. Select the limit points defining the end of each notch
10. Click Fill Cutout
11. Right-click once completed

12. To set stamping direction, click Orient

13. Select Align to Global Y Axis
14. Right-click when completed

15. Click Add/Edit Blank Holder under Constrain

16. Select the highlighted surfaces
17. Click on the highlighted surface once and enter a value of 10 tf (98067N)
18. Click Add/Edit Drawbead under Constrain
19. Select the highlight edge
20. Click on the highlighted edge again to define a restraining force value
21. Click on L (Low).
   
   *Note: you are given the option to choose between L (Low), M (Medium), H (High), or defining your own value*

22. Right-click when completed

Step 2: Running the Analysis

1. Right-Click on the model and select Material Library...
2. Select SAE_J2340_HR_550X_HSLA
3. Click Assign and Close
4. Click on the Run icon in Analysis
5. Click Run
6. Once the run is completed, click on the green flag to view the results
7. Click on animate to observe the unfolding of the part into a flat blank
8. Under File, select Preferences...
9. Select Feasibility under Click2Form
10. Change the legend color of ‘Thinning’ to Rainbow
11. Click Apply and OK
12. Right-click once completed

13. Click **Fit**

*Note: Fit is used as a tool to fit the unfolded flat blank into a variety of standard shape*

14. Change the Addendum to **50.00mm**

15. Select all the fitted shapes

16. Click **Run**

17. Once the run is completed, click on the **green flag** to view the results

*Note: a HTML report is created*

### Blank Fit Summary

<table>
<thead>
<tr>
<th>S No.</th>
<th>Part Name</th>
<th>Material</th>
<th>Thickness (mm)</th>
<th>Blank Fit Shape</th>
<th>Material Utilization (%)</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Surface_Offset_1_Midsurface_1</td>
<td>CRDQ Steel</td>
<td>1.000</td>
<td>Rectangle</td>
<td>43.73</td>
<td>Report</td>
</tr>
<tr>
<td>2</td>
<td>Surface_Offset_1_Midsurface_1</td>
<td>CRDQ Steel</td>
<td>1.000</td>
<td>Parallelogram</td>
<td>43.77</td>
<td>Report</td>
</tr>
<tr>
<td>3</td>
<td>Surface_Offset_1_Midsurface_1</td>
<td>CRDQ Steel</td>
<td>1.000</td>
<td>Regular Trapezoid</td>
<td>52.07</td>
<td>Report</td>
</tr>
<tr>
<td>4</td>
<td>Surface_Offset_1_Midsurface_1</td>
<td>CRDQ Steel</td>
<td>1.000</td>
<td>Irregular Trapezoid</td>
<td>50.95</td>
<td>Report</td>
</tr>
<tr>
<td>5</td>
<td>Surface_Offset_1_Midsurface_1</td>
<td>CRDQ Steel</td>
<td>1.000</td>
<td>Sweep</td>
<td>47.86</td>
<td>Report</td>
</tr>
<tr>
<td>6</td>
<td>Surface_Offset_1_Midsurface_1</td>
<td>CRDQ Steel</td>
<td>1.000</td>
<td>Chevron</td>
<td>46.32</td>
<td>Report</td>
</tr>
</tbody>
</table>
18. Click Nest

*Note: Blank Nesting tool is used to optimize material utilization for transfer and die progressive die stamping*

19. Change the Addendum to **30.00mm**

20. Select **Progressive Die**

21. Ensure Carrier Type is checked and select **Central**

22. Click **Run**

23. Once the run is completed, click on the **green flag** to view the results

*Note: a HTML report is created*

---

<table>
<thead>
<tr>
<th>S No.</th>
<th>Part Name</th>
<th>Material</th>
<th>Thickness (mm)</th>
<th>Process Type</th>
<th>Blank Fit Shape</th>
<th>Pattern</th>
<th>Carrier Type</th>
<th>Material Utilization (%)</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp</td>
<td>Central</td>
<td>69.43</td>
<td>Report</td>
</tr>
<tr>
<td>2</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp</td>
<td>Central</td>
<td>69.92</td>
<td>Report</td>
</tr>
<tr>
<td>3</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp</td>
<td>Central</td>
<td>70.24</td>
<td>Report</td>
</tr>
<tr>
<td>4</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp</td>
<td>Central</td>
<td>70.67</td>
<td>Report</td>
</tr>
<tr>
<td>5</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp</td>
<td>Central</td>
<td>71.08</td>
<td>Report</td>
</tr>
<tr>
<td>6</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp-Flip</td>
<td>Central</td>
<td>69.43</td>
<td>Report</td>
</tr>
<tr>
<td>7</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp-Flip</td>
<td>Central</td>
<td>69.92</td>
<td>Report</td>
</tr>
<tr>
<td>8</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp-Flip</td>
<td>Central</td>
<td>70.24</td>
<td>Report</td>
</tr>
<tr>
<td>9</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp-Flip</td>
<td>Central</td>
<td>70.67</td>
<td>Report</td>
</tr>
<tr>
<td>10</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp-Flip</td>
<td>Central</td>
<td>71.08</td>
<td>Report</td>
</tr>
<tr>
<td>11</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp-MiinerX</td>
<td>Central</td>
<td>69.43</td>
<td>Report</td>
</tr>
<tr>
<td>12</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp-MiinerX</td>
<td>Central</td>
<td>69.92</td>
<td>Report</td>
</tr>
<tr>
<td>13</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp-MiinerX</td>
<td>Central</td>
<td>70.24</td>
<td>Report</td>
</tr>
<tr>
<td>14</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp-MiinerX</td>
<td>Central</td>
<td>70.67</td>
<td>Report</td>
</tr>
<tr>
<td>15</td>
<td>Surface_Offset__1_Midsurface_1</td>
<td>CRDG Steel</td>
<td>1.00</td>
<td>Progressive</td>
<td>None</td>
<td>TwoUp-MiinerX</td>
<td>Central</td>
<td>71.08</td>
<td>Report</td>
</tr>
</tbody>
</table>
Appendix I – Click2Cast

Step 1. Geometry
1. Launch Click2Cast
2. Click New Project.
3. Open wheel.stl
4. Set the length units to mm.

5. Click NEXT

Note: You can also go to the next step using the step bar controller.

Step 2. Meshing
1. Select AUTOMATIC.

   Note: The ingate is the area where the material enters the part. Since an ingate was already defined in the CAD tool, select AUTOMATIC.

2. Define the orientation as YZ

3. Click on Add Ingate

4. Click on the highlighted piston area. The ingate will be defined at the flat surface
5. Under Mesh, enter an **Element size of 5 mm**

6. Click on **Create mesh** to generate the mesh.

7. Double-Click the **Mesh** icon on the right toolbar to view the FE mesh.

8. Click **NEXT**

**Step 3. Parameters**

1. Under Part Material, select **Aluminum** and **AlSi7Mg** for the Group and Type.
2. Set the **Temperature** to **700°C**.
3. Select **Steel-H13** as the mold material.
4. Set the **Temperature** to **150°C**.
5. Set the **Gravity direction** to **+ X**.
6. Select **Advanced** and then select **Low Pressure - DC**.
   
   *Note: The Gravity direction refers to the position of the part relative to the mold.*
7. Enter a value of **800 mm** for the **Distance** (distance from crucible to mold*)

8. Enter the following **Pressure Curve** values:

   *Note: The initial value must take into account the distance entered to start filling the Part (800 mm). The initial value must be higher than 188mbar to reach the mold.*

<table>
<thead>
<tr>
<th>T (msec)</th>
<th>P (mbar)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0,0</td>
<td>190</td>
</tr>
<tr>
<td>1000</td>
<td>205</td>
</tr>
<tr>
<td>2000</td>
<td>210</td>
</tr>
<tr>
<td>5000</td>
<td>215</td>
</tr>
<tr>
<td>10000</td>
<td>220</td>
</tr>
</tbody>
</table>

9. Click NEXT

**Step 4. Calculate**

1. Under **Analysis**, select **Filling**.
2. Click **Calculate** and wait for it to complete
3. Click NEXT

**Step 5. Results**

1. Click **Flow Front**
2. Click the **Play** button to start the animation

*Note: Looking at the results, you can see that the pressure was not high enough for the mold to fill completely.*
3. Click **Temperature**
4. Define the **Orientation** as YZ
5. Click the **Scissors** icon and select two points along the radius of the wheel
6. Click **Labels** and select different areas of the section

   *Note: Use the Labels option to analyze changes in temperature during filling at a particular point in the geometry.*

7. Click the **Graph** icon and select different areas of the section. Press **Esc**

   *Note: Analyze the part’s solidification behavior using the temperature curves*

8. Click **Solid Fraction**
Note: A value of 0 corresponds to a completely liquid material, while a value of 1 corresponds to a completely solid material. The solid fraction results indicate that the part has not been completely filled. This means that you need to increase the pressure. Solidification in C2C stops when front liquid is over 0.6 % (when liquid stops flowing).

9. Click the back arrow to return to the PARAMETERS step
10. Increase the Pressure values

<table>
<thead>
<tr>
<th>T (msec)</th>
<th>P (mbar)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0,0</td>
<td>200</td>
</tr>
<tr>
<td>1000</td>
<td>230</td>
</tr>
<tr>
<td>2000</td>
<td>250</td>
</tr>
<tr>
<td>5000</td>
<td>280</td>
</tr>
<tr>
<td>10000</td>
<td>300</td>
</tr>
</tbody>
</table>

11. Click NEXT
12. Repeat the steps for CALCULATE, and go to the RESULTS step
13. Click Solid Fraction
14. The part is filled completely this time